If you encounter a problem in MS Word and are unable to find a solution in this document, please use Microsoft Office Support: https://support.office.com/

If you are unable to resolve your issue using Microsoft Office Support, send us an email and we will do our best to assist you: gradhelp@purdue.edu

Updated 08/25/2015
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>BEFORE YOU BEGIN</td>
<td>5</td>
</tr>
<tr>
<td>Template Use Options</td>
<td>5</td>
</tr>
<tr>
<td>OS &amp; Version Guidelines</td>
<td>5</td>
</tr>
<tr>
<td>Familiarizing Yourself with MS Word</td>
<td>5</td>
</tr>
<tr>
<td>Formatting Help</td>
<td>5</td>
</tr>
<tr>
<td>Writing Help</td>
<td>5</td>
</tr>
<tr>
<td>Protecting the Integrity of Research Data and Documents</td>
<td>6</td>
</tr>
<tr>
<td>Saving Your Document</td>
<td>6</td>
</tr>
<tr>
<td>Sample Pages</td>
<td>6</td>
</tr>
<tr>
<td>Formatting Checklist</td>
<td>6</td>
</tr>
<tr>
<td>GETTING STARTED</td>
<td>7</td>
</tr>
<tr>
<td>Thesis/Dissertation Organization</td>
<td>7</td>
</tr>
<tr>
<td>Formatting Order</td>
<td>7</td>
</tr>
<tr>
<td>GENERAL GUIDELINES</td>
<td>8</td>
</tr>
<tr>
<td>Paper Size</td>
<td>8</td>
</tr>
<tr>
<td>Margins</td>
<td>8</td>
</tr>
<tr>
<td>Font</td>
<td>8</td>
</tr>
<tr>
<td>Font Size</td>
<td>8</td>
</tr>
<tr>
<td>Line Spacing</td>
<td>8</td>
</tr>
<tr>
<td>Pagination</td>
<td>9</td>
</tr>
<tr>
<td>Headings &amp; Chapter Titles</td>
<td>9</td>
</tr>
<tr>
<td>Departmental Style</td>
<td>9</td>
</tr>
<tr>
<td>Sample Pages</td>
<td>9</td>
</tr>
<tr>
<td>PAGE SPECIFIC GUIDELINES</td>
<td>10</td>
</tr>
<tr>
<td>Front Matter</td>
<td>10</td>
</tr>
<tr>
<td>Title Page</td>
<td>10</td>
</tr>
<tr>
<td>Dedication</td>
<td>10</td>
</tr>
<tr>
<td>Acknowledgements</td>
<td>10</td>
</tr>
<tr>
<td>Table of Contents</td>
<td>11</td>
</tr>
<tr>
<td>List of Tables</td>
<td>11</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>List of Figures</td>
<td>11</td>
</tr>
<tr>
<td>Nomenclature</td>
<td>11</td>
</tr>
<tr>
<td>Glossary</td>
<td>12</td>
</tr>
<tr>
<td>List of Symbols</td>
<td>12</td>
</tr>
<tr>
<td>List of Abbreviations</td>
<td>12</td>
</tr>
<tr>
<td>Abstract</td>
<td>12</td>
</tr>
<tr>
<td>Publication or Publications</td>
<td>12</td>
</tr>
<tr>
<td>Body of Thesis/ Dissertation</td>
<td>13</td>
</tr>
<tr>
<td>Chapters</td>
<td>13</td>
</tr>
<tr>
<td>Back Matter</td>
<td>14</td>
</tr>
<tr>
<td>References</td>
<td>14</td>
</tr>
<tr>
<td>Appendix or Appendices</td>
<td>14</td>
</tr>
<tr>
<td>Notes or Footnotes</td>
<td>14</td>
</tr>
<tr>
<td>Vita</td>
<td>15</td>
</tr>
<tr>
<td>Publication or Publications</td>
<td>15</td>
</tr>
<tr>
<td>HOW TO</td>
<td>16</td>
</tr>
<tr>
<td>Margins &amp; Page Numbers</td>
<td>16</td>
</tr>
<tr>
<td>Change top margins</td>
<td>16</td>
</tr>
<tr>
<td>Update/change page numbers</td>
<td>17</td>
</tr>
<tr>
<td>Fonts &amp; Spacing</td>
<td>17</td>
</tr>
<tr>
<td>Get consistent spacing</td>
<td>17</td>
</tr>
<tr>
<td>Table of Contents</td>
<td>18</td>
</tr>
<tr>
<td>Create an automatically populated Table of Contents using Styles</td>
<td>18</td>
</tr>
<tr>
<td>To modify the styles in the Styles box</td>
<td>19</td>
</tr>
<tr>
<td>To update your Table of Contents</td>
<td>20</td>
</tr>
<tr>
<td>Troubleshooting the Table of Contents</td>
<td>20</td>
</tr>
<tr>
<td>List of Tables/List of Figures</td>
<td>22</td>
</tr>
<tr>
<td>Create a List of Tables</td>
<td>22</td>
</tr>
<tr>
<td>Create a List of Figures</td>
<td>22</td>
</tr>
<tr>
<td>Insert a Continued Table Caption</td>
<td>22</td>
</tr>
<tr>
<td>Add Appendix figure/table captions to a List of Figures/List of Tables</td>
<td>23</td>
</tr>
<tr>
<td>Figure/Table Captions</td>
<td>23</td>
</tr>
<tr>
<td>Insert table/figure captions</td>
<td>23</td>
</tr>
<tr>
<td>Change the way Appendix figures/tables are numbered</td>
<td>24</td>
</tr>
<tr>
<td>Footnotes</td>
<td>25</td>
</tr>
<tr>
<td>Restart footnote numbering with each chapter</td>
<td>25</td>
</tr>
<tr>
<td>Landscape Pages</td>
<td>Page</td>
</tr>
<tr>
<td>-----------------</td>
<td>------</td>
</tr>
<tr>
<td>To get a landscape page</td>
<td>25</td>
</tr>
<tr>
<td>To correct the placement of a page number on a landscape page</td>
<td>25</td>
</tr>
<tr>
<td>Cover Pages</td>
<td>Page</td>
</tr>
<tr>
<td>To hide the page number on a cover page</td>
<td>28</td>
</tr>
<tr>
<td>To paginate after a cover page</td>
<td>28</td>
</tr>
<tr>
<td>To insert cover pages using Adobe Acrobat Pro</td>
<td>28</td>
</tr>
<tr>
<td>Embedding Fonts</td>
<td>Page</td>
</tr>
<tr>
<td>To embed your fonts</td>
<td>29</td>
</tr>
<tr>
<td>Converting Word Files to PDF</td>
<td>Page</td>
</tr>
<tr>
<td>To convert using Acrobat</td>
<td>29</td>
</tr>
<tr>
<td>To combine PDF Files using Acrobat</td>
<td>30</td>
</tr>
<tr>
<td>To insert or replace pages in PDF using Acrobat</td>
<td>30</td>
</tr>
</tbody>
</table>
BEFORE YOU BEGIN

Template Use Options

This document contains instructions and troubleshooting guidelines to help you as you use MS Word to format your thesis/dissertation. It can be used whether or not you use our templates.

OS & Version Guidelines
We do not support the use of our MS Word templates with versions of MS Word older than 2010. We do not support the use of our MS Word templates with Pages for Mac, LibreOffice, or Apache OpenOffice.

Familiarizing Yourself with MS Word
If you are not experienced with MS Word, consider watching some of Microsoft’s training videos before you begin formatting:
https://support.office.com/en-us/article/Office-training-and-tutorials-b8f02f81-ec85-4493-a39b-4c48e6bc4bfb

Formatting Help
If you encounter a problem in MS Word and are unable to find a solution in this document, please use Microsoft Office Support: https://support.office.com/

If you are unable to resolve your issue using Microsoft Office Support, send us an email and we will do our best to assist you: gradhelp@purdue.edu

Writing Help
The Purdue Writing Lab offers tutoring appointments for help with specific writing-related issues. Visit the Writing Lab website for scheduling and location information: https://owl.english.purdue.edu/writinglab/
Protecting the Integrity of Research Data and Documents

It is important that you preserve your research notes and data. If you are ever charged with scientific misconduct, your notes can help verify that you used sound methodology and that your research is your own.

Maintaining draft and intermediate copies of your manuscript is another important step in protecting your research claim. Your case for originally is strengthened if you can produce early versions of your work, as these show the development of your ideas and thought processes. If you are accused of plagiarism, drafts of your thesis can be crucial evidence in your favor.

Saving Your Document

We strongly recommend you regularly save and back up your thesis/dissertation file. Your file should be saved in a minimum of two places, in addition to your computer’s hard drive.

Never turn off your computer while your thesis/dissertation file is saving, as most corruption occurs when something goes wrong while a file is being saved. Always close your thesis/dissertation file before you turn off your computer, turn off your computer properly to minimize the risk of corrupting your thesis/dissertation file, and protect your computer’s power with either a surge protector, suppressor or with an uninterruptible power supply.

Sample Pages

This document is not an example of a Purdue Style thesis. Its purpose is to convey formatting information. For examples of a properly formatted Purdue thesis/dissertation refer to the Sample Pages on the Templates page of our website:

http://www.purdue.edu/gradschool/research/thesis/templates.html

Formatting Checklist

Before you convert your document to PDF, please review each page carefully for typos and inconsistencies. Then, check the document using our Formatting Checklist, available on the Templates & Guidance page of our site:

http://www.purdue.edu/gradschool/research/thesis/templates.html
GETTING STARTED

Thesis/Dissertation Organization

1. FRONT MATTER:
   a. Form 30 (required—attach after you convert to PDF)
   b. Title page (required)
   c. Dedication
   d. Acknowledgements
   e. Table of Contents (required)
   f. List of Tables
   g. List of Figures
   h. Nomenclature
   i. Glossary
   j. List of Symbols
   k. List of Abbreviations
   l. Abstract (required)
   m. Publication

2. BODY (CHAPTERS)

3. BACK MATTER:
   a. References (required)
   b. Appendix or Appendices
   c. Notes
   d. Footnotes
   e. Vita (required for Ph.D. candidates/optional for Master’s candidates)
   f. Publications

Formatting Order

To minimize the risk of having to format items twice, we suggest formatting in this order:

1. Body of Thesis/Dissertation - text only
2. Back Matter - text only
3. Front Matter - text only (except Table of Contents, List of Tables, and List of Figures)
4. Body of Thesis/Dissertation - top margins and page numbers
5. Back Matter - top margins, page numbers and cover pages
6. Table of Contents, List of Tables, and List of Figures - text only
7. Front matter - top margins and page numbers
8. Convert to PDF and attach Form 30
GENERAL GUIDELINES

Paper Size
- Use LETTER (8 ½” by 11”) paper size for your thesis when converting to PDF
- Before you convert to PDF, be sure Adobe Acrobat is not defaulted to a metric sized paper setting (such as A4)

Margins

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>LEFT</td>
<td>1.5”</td>
</tr>
<tr>
<td>RIGHT</td>
<td>1”</td>
</tr>
<tr>
<td>BOTTOM</td>
<td>1.25”</td>
</tr>
<tr>
<td>TOP</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2”: First page of a section/chapter</td>
</tr>
<tr>
<td></td>
<td>1”: Second page in section/chapter &amp; all subsequent pages</td>
</tr>
</tbody>
</table>

Font
- Use only one font throughout document
- Font must be easy to read
- The font size used in chapters should match the line spacing used in Front Matter pages and Back Matter pages, and for page numbers

Font Size
- Body text should be either 11 or 12 point
- Captions, footnotes, and table text may be 10 point
- The font size used in chapters should match the line spacing used in Front Matter pages and Back Matter pages, and for page numbers

Line Spacing
- Body text should use either 1.5 point line spacing or 2 point (double) line spacing
- Captions, footnotes, and table text may be single spaced
- The line spacing in chapters should match the line spacing in Front Matter and Back Matter pages
Pagination

- Placed in top right corner:
  - .5” from top edge
  - 1” from right edge
- Use lowercase Roman numerals in Front Matter pages (ii, iii, iv)
- Use Arabic numerals in body of text (chapters) and Back Matter pages (1, 2, 3)
- Restart numbering when you switch to Arabic numerals (first page of Chapter 1 is page number 1)

Headings & Chapter Titles

- The first page of a section or chapter must have a heading
- Headings must be:
  - Centered on page
  - In all-caps
- Include an After Space setting or 30 or 3 single spaced blank lines between heading and first line of text

Departmental Style

- Your department/major professor can provide guidance on what style is preferred in your discipline.

Sample Pages

- Sample thesis/dissertation pages can be found on the Templates page of the Thesis/Dissertation Office website:
  http://www.purdue.edu/gradschool/research/thesis/templates.html
PAGE SPECIFIC GUIDELINES

Front Matter

Title Page
- REQUIRED
- Not listed in Table of Contents
- No visible page number, but technically page i
- Spacing must be consistent between “blocks” of text
- Text centered between right and left margins (margins are same as any other page)
- Thesis/dissertation title is in all caps
- Your name, thesis/dissertation title, and degree title must match GS Form 30 & Abstract page
- Date is graduation month and year (May, August, or December only)
- Example: December 2014
- Location is full name of campus city and Indiana (not abbreviated)
- Example: West Lafayette, Indiana

Dedication
- OPTIONAL
- Not listed in Table of Contents
- Page number is ii
- Do not include a heading
- Center text on the page
- Non-English text is allowed

Acknowledgements
- OPTIONAL
- Not listed in Table of Contents
- Text spacing same as in main body of text (either 1.5 point or 2 point)
**Table of Contents**
- **REQUIRED**
  - Text spacing same as in main body of text (either 1.5 point or 2 point)
  - Paginated in lowercase Roman numerals
  - Page number column should align with right margin
  - Put major headings/chapter titles in all caps
  - Avoid gaps in leader dots: .......... ....... .......
  - Page mini-header appears above page column on all pages
  - Don’t list your Table of Contents in your Table of Contents

**List of Tables**
- **OPTIONAL**
  - Text spacing same as in main body of text (either 1.5 point or 2 point)
  - Paginated in lowercase Roman numerals
  - Be consistent
  - Page number column should align with right margin
  - Avoid gaps in leader dots: .......... ....... .......
  - Table mini-header appears above table column on all pages
  - Page mini-header appears above page column on all pages

**List of Figures**
- **OPTIONAL**
  - Text spacing same as in main body of text (either 1.5 point or 2 point)
  - Paginated in lowercase Roman numerals
  - Be consistent
  - Page number column should align with right margin
  - Avoid gaps in leader dots: .......... ....... .......
  - Figure mini-header appears above table column on all pages
  - Page mini-header appears above page column on all pages

**Nomenclature**
- **OPTIONAL**
  - Text spacing same as in main body of text (either 1.5 point or 2 point)
  - Paginated in lowercase Roman numerals
  - If glossaries are 2+ pages, they may be placed in the back before References
Glossary
  o OPTIONAL
  o Text spacing same as in main body of text (either 1.5 point or 2 point)
  o Paginated in lowercase Roman numerals
  o If glossaries are 2+ pages, they may be placed in the back before References

List of Symbols
  o OPTIONAL
  o Text spacing same as in main body of text (either 1.5 point or 2 point)
  o Paginated in lowercase Roman numerals
  o If glossaries are 2+ pages, they may be placed in the back before References

List of Abbreviations
  o OPTIONAL
  o Text spacing same as in main body of text (either 1.5 point or 2 point)
  o Paginated in lowercase Roman numerals
  o If glossaries are 2+ pages, they may be placed in the back before References

Abstract
  o REQUIRED
  o Text spacing same as in main body of text (either 1.5 point or 2 point)
  o Paginated in lowercase Roman numerals
  o Name/title/degree/date must match GS Form 30 & title page
  o Thesis/dissertation title: Don’t use all caps or quotation marks
  o Titles/departments of major professor(s) not required
  o Don’t include images, tables or figures

Publication or Publications
  o OPTIONAL
  o If listing: text spacing same as in main body of text (either 1.5 point or 2 point)
  o Scans of original publications may be used
  o Must be legible and meet margin & page number requirements
  o Want to use articles as chapters? Please check with Thesis/Dissertation Office first
  o Alternate placement: In BACK MATTER, after Vita
Body of Thesis/ Dissertation

Chapters

- REQUIRED
- Divide your thesis/dissertation into unless instructed otherwise by your departmental thesis advisor
- Use Arabic numerals (first page of Chapter 1 is 1)
- Use consistent fonts and styles
- If including References as part of a chapter:
  - treat as first-order subdivision
  - don’t use all caps for References subheading
- References may also be included at end; see: BACK MATTER
- If including Notes as part of a chapter:
  - treat as first-order subdivision
  - don’t use all caps for Notes or Footnotes subheading
- Notes may also be included at end; see: BACK MATTER
- If including Footnotes as part of a chapter:
  - single spacing and 10 point font are allowed
  - when possible, do not allow a single footnote to span multiple pages
- Footnotes may also be included at end; see: BACK MATTER
Back Matter

References
- REQUIRED
- This section has an unnumbered cover page before it—cover page not included in page count
- Use Arabic numerals (continued from BODY OF THESIS/DISSERTATION)
- Text spacing same as in main body of text (either 1.5 point or 2 point)
- Don't let a reference entry be split between two pages—if one of your entries appears on two pages: push entire entry to second page
- Follow departmental citation style if one is provided—if not, you may select your own citation style as long as you are consistent

Appendix or Appendices
- OPTIONAL
- This section has an unnumbered cover page before it—cover page not included in page count
- For single APPENDIX:
  - Treat it as a major division heading (2" top margin, heading in all caps, etc.)
- For multiple APPENDICES:
  - Treat each first page of a section as a first order subdivision (1" top margin, only capitalize first letter of major words in heading, etc.)
  - Use letters for multiple appendices--don't number them

Notes or Footnotes
- OPTIONAL
- This section has an unnumbered cover page before it—cover page not included in page count
- Text spacing same as in main body of text (either 1.5 point or 2 point)
- Don't let a note or footnote entry be split between two pages—if one of your entries appears on two pages: push entire entry to second page
- Follow your department's guidelines for notes or footnotes style
Vita

- REQUIRED for Ph.D. candidates
- OPTIONAL for Master’s candidates
- This section has an unnumbered cover page before it—cover page not included in page count
- Text spacing same as in main body of text (either 1.5 point or 2 point)
- Content of VITA determined by department needs, but do not include photographs or creative formatting
- Narrative style and Curriculum Vitae style and both permitted, but the heading is always VITA
- DO NOT INCLUDE ANY PRIVATE INFORMATION (such as home address or cell phone number)

Publication or Publications

- OPTIONAL
- If listing: text spacing same as in main body of text (either 1.5 point or 2 point)
- Scans of original publications may be used
- Must be legible and meet margin & page number requirements
- Want to use articles as chapters? Please check with Thesis/Dissertation Office first
- Alternate placement: In FRONT MATTER, after Abstract
HOW TO

Margins & Page Numbers

Change top margins

1. Turn on Show Formatting Marks (¶ button in Paragraph Section of Home tab of Ribbon)
2. Insert a Section Break: Next Page* before the page to which you want to apply a 2” top margin
3. Click on text in the page to which you want to apply a 2” top margin
4. In Ribbon, click on Page Layout tab
5. Click on Margins in the Page Setup section
6. Click Custom Margins
7. Set top margin to 2”
8. Click Okay
9. Insert a Section Break: Next Page at the bottom of the page to which you have applied a 2” top margin

Now you need to reset the margins on the page after the 2” top margin page if it is a regular page

1. Click on text in the page to which you want to apply a 1” top margin (page after 2” top margin page)
2. In Page Layout, click on Margins, then Custom Margins
3. Set the top margin to 1”

*Please note that the name of the section break you’ll want to use is Section Break: Next Page. If you use a different kind of break you will not get the same result.
Update/change page numbers

1. Put cursor in header area
2. Click on Edit Header
3. In Navigation section of the Design tab, make sure Link to Previous is not checked (if checked it is highlighted in yellow)
4. In Header & Footer section of the Design tab in the Ribbon, click on Page Number
5. Click Format Page Numbers
6. To continue the page numbering from the previous page, select Continue from Previous Section
7. To enter a custom page number, select Start at:, then enter the desired page number

If the page number does not update after you do the above:

1. In Header & Footer section of the Design tab in the Ribbon, click on Page Number
2. Click Top of Page
3. In the Simple section, choose Plain Number Three (page number appears in top right of page)

Fonts & Spacing

Get consistent spacing

1. Place the cursor on the line where you want to add After Space
2. Go to Page Layout menu
3. Determine the amount of space needed and insert the corresponding number in the box under Spacing

<table>
<thead>
<tr>
<th>After Space Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>24</td>
</tr>
<tr>
<td>▪ Equal to double spacing</td>
</tr>
<tr>
<td>▪ We recommend you use this after figure captions or table captions</td>
</tr>
<tr>
<td>36</td>
</tr>
<tr>
<td>▪ Equal to 3 single spaced blank lines; equal to 1 inch</td>
</tr>
<tr>
<td>▪ We recommend you use this after title page blocks</td>
</tr>
<tr>
<td>▪ We require you to use this after major headings and chapter headings</td>
</tr>
</tbody>
</table>
Table of Contents

Create an automatically populated Table of Contents using Styles

The Styles function is mainly used for expedited Table of Contents creation. A number of styles are already defined in the template, up to SubH4 (which appears in the document as a five digit subheading; i.e., 1.1.1.1.1).

While you may add additional subheading levels beyond five digits, we don’t recommend using the Styles function on these, since your Table of Contents should not include subheading levels beyond five digits.

- **PART I: Correctly Assign Styles**
  
  To apply or to restore styles to your heading:

  1. Click on the heading and highlight it.
  2. Choose the appropriate style for the heading from the Styles section in the Ribbon of the Home tab (major headings are MajorH, chapter headings are ChapterH, subheadings are SubH1, SubH2, etc.)
  3. When the style is applied on the heading, you will see a black dot in front of your heading (only when Show Formatting Marks (¶ button in Paragraph Section of Home tab of Ribbon) function is activated) and a yellow border will appear around the style in the Styles section in the Ribbon if you have your cursor in the heading.

*The template Table of Contents is designed to include Styles: MajorH, ChapterH, SubH1, SubH2, SubH3, SubH4*

- **PART II: Update Table**

  1. Right click in table area
  2. Select Update field
  3. Select Update entire table
  4. Click Okay
• **PART III: Change the Styles that appear in your Table (OPTIONAL)**
  1. In Ribbon, click on References tab
  2. In Table of Contents section, click on Table of Contents
  3. Select Insert Table of Contents
  4. Click Options
  5. Use the check boxes at left to designate which Styles you want to be added to the table
  6. Use the numbers at right to assign the level that Style will have in the table
     (major headings and chapter headings should be set at position 1)

**To modify the styles in the Styles box**
  1. Go to Home tab.
  2. Select the heading style that you wish to modify by right clicking the style box.
  3. Choose “Modify” from the listed menu.
  4. Click Format menu on the left bottom to apply additional setting such as line space or before/after space.
  5. Click Okay to close Modify Style window.
  6. If your headings don’t change automatically to the new style, go back to your heading and manually apply the style.
  7. You can always manually apply the changes to each heading. If you manually change your heading style, you may need to manually make changes to your Table of Contents, as well, since it may not update properly.
To update your Table of Contents

1. Go to TOC page and right click anywhere on the list for the menu, Update Field while the entire list is highlighted in dark grey.
2. Choose Update Page Numbers Only or Update Entire Table to reload/reset current TOC list.

Word automatically creates line space for the TOC based on your headings. If you wish to use different line spacing, highlight entire TOC and right click for Paragraph option. Line spacing of 1.5 is recommended, but the automatic spacing will be accepted.

As a last step of formatting the TOC, add mini-heading, Page, above the list aligned to the right with consistent line space. If the TOC has more than one page, rest of the TOC pages (pages of 2\textsuperscript{nd}, 3\textsuperscript{rd}, 4\textsuperscript{th}, etc.) must start with mini-heading Page, and use a 1” top margin and 1” right margin.

Troubleshooting the Table of Contents

- The Dotted Line is Missing
  When a dotted line is missing between the heading and page number of the list, you can simply press Tab button right after the heading to create it back. Most of the time will immediately generate the dotted line with the proper alignment for the entry.

- The Text is Not Aligned at the Left
  All of the TOC entries must set with left alignment while different level of indentation is applied on the heading. Sometimes, you may find subheading 1 (e.g., 1.1) is right aligned instead of left aligned. If you encounter this problem, highlight the line and select left alignment from the Paragraph section of the Home tab.

- There are Leader Dots on a Line with No Text
  If your heading title is too long to fit on a single line, it is acceptable for your heading to be continued on an additional line or lines. There should always be at least one word on a line which contains leader dots. If a line has leader dots but not words, manually move down the last word from previous line using space bar until it reaches correct place.
• Bookmark Errors
  1. Highlight your Table of Contents
  2. Press Ctrl+F11

  This will lock the text in your Table of Contents.

  If you later want to make changes the Table of Contents, unlock your text:
  1. Highlight your Table of Contents
  2. Press Ctrl+Shift+F11

• To create a new Table of Contents

  If you are having problems formatting your TOC that you are unable to correct manually using the Paragraph section of the Home tab or the Backspace button, you may wish to start over with your TOC and make a new one.

  1. Go to References tab and choose Automatic Table 2 from Table of Contents drop down box.

  2. Manually format major heading TABLE OF CONTENTS, 2” top margin on first page and 1” margin on any subsequent pages, and type in the mini-heading Page above the column of page numbers on every page of the TOC.

  3. Set Before Space on TABLE OF CONTENTS to 0.

  4. If necessary, change the font so that it is consistent with rest of the text in style, size and color.

  5. Include 3 single spaced blank lines between the heading and the first line of text.

  6. First page of the TOC should be 2” top margin, and use 1” on rest of the continued TOC pages.

  7. Manually add mini-heading, Page, above the page number column on all pages, aligning to the right.

  8. Remember to update the page numbers on your TOC when changes are made to the body of your document.
List of Tables/List of Figures

Create a List of Tables

1. Go to References tab.
2. Click Insert Table of Figures and change the caption label to Table.
3. If you have used multiple labels for table captions, LIST OF TABLES will not automatically include them. It has to be created for each label. To add them, repeat creation process by selecting the name of each label from Caption Label.
4. When the list is created, you must manually type in mini-headings, Table and Page above the list (Table over the table caption column and aligned left/Page over the page numbers column and aligned right). If you see a dotted line between the mini-headings Table and Page, change the font color of the dots to white.

Create a List of Figures

1. Go to References tab.
2. Click Insert Table of Figures and set the caption label to Figure.
3. If you have used multiple labels for table captions, LIST OF FIGURES will not automatically include them. It has to be created for each label. To add them, repeat creation process by selecting the name of each label from Caption Label.
4. When the list is created, you must manually type in mini-headings, Figure and Page above the list (Figure over the figure caption column and aligned left/Page over the page numbers column and aligned right). If you see a dotted line between the mini-headings Table and Page, change the font color of the dots to white.

Insert a Continued Table Caption

If your table is too big, font size, bottom margin, and right margin could be adjusted to have the table fit in one page. When your table is continued over multiple pages, additional caption is required on each continuing page (e.g., Table 2.1 Cont. or Table 2.1 Continued.) as shown on Table 2.3.

1. Click any cells of the last row (one of the last 2 rows is recommended).
2. Insert Page Break from Page Layout tab.
3. Place a cursor after Page Break, then hit the Enter button to insert the necessary amount of blank space.
4. Type continued caption above continued table.
Add Appendix figure/table captions to a List of Figures/List of Tables

1. Put your cursor below the last entry in your current List of Figures
2. In the Ribbon, click References
3. In the Captions, tab click Insert Table of Figures
4. Make sure the boxes for Show page numbers and Right align page numbers are both checked
5. For Tab leader: choose .......
6. For Formats: choose From template
7. For Caption label: choose that label you used for your Appendix captions
8. Type in the mini-header Appendix Table between your last regular chapter caption and your first appendix table caption

Figure/Table Captions

Insert table/figure captions

There are two ways to insert table captions: one is through References menu and by right clicking the table. (If you’re not going to create LIST OF TABLES, caption can be typed manually.)

The Insert Caption function plays very important role if you do not want to worry about numbering, and you rely on Word creating LIST OF TABLES for you.

- Option 1: Using the References Menu
  1. Place the cursor above the table to insert caption.
  2. Go to References menu and click Insert Caption.
  3. Set options to meet your preference.
• **Option 2: Right Clicking the Table**
  1. Insert your table.
  2. Click 4-way Cross Sign which will appear when you move your mouse close to a table or click the table.
  3. Select Insert Caption.
  4. Format your caption as your need starting with Numbering style.

Currently, captions are set up to include the chapter number, but if you would like it to read Table 1, Table 2, Table 3, etc., go to Numbering and uncheck the Include Chapter Number box.

If your table caption is too long, you can divide sections of your caption using the Enter button.

Appendix table caption must contain appendix subheading (a letter) in the numbering (e.g., Table A.1, A.2, B.1, etc.). There are a couple of ways to number appendix table:

  1. It can be typed in.
  2. It can be created by assigning New Label for the table caption.

If you have decided not to include chapter number in your table caption, appendix table caption rule does not apply to you. Continue to number your table caption as Table 1, Table 2, Table 3, etc.

**Change the way Appendix figures/tables are numbered**

  1. Put your cursor above the table you want to caption
  2. In the Ribbon, go to References
  3. In the Captions tab, click Insert Caption
  4. Click New Label
  5. Type Table A.
  6. Click OK
  7. Click OK
  8. Paste the rest of your caption text
Footnotes

Restart footnote numbering with each chapter

1. Highlight the first footnote of a chapter
2. Then, click on References tab in the top Ribbon
3. Click on the expander button in the lower right corner of the Footnotes section
4. In the Format section, set Start at: to 1
5. In the Numbering line, choose Restart each section
6. Click Apply

If you are using Styles on your chapter headings you shouldn’t have to do this on every new chapter, since it should recognize the new chapter as a new section, but do check each chapter to be sure. If for some reason it doesn’t auto-update or if you aren’t using Styles on your chapter headings, you’ll need to do this manually for the first footnote of each chapter.

Landscape Pages

We think the steps listed below are the easiest way to deal with landscape pagination—and the way least likely to cause you problems on other pages. But if you don’t like this method, you’ll find some other options using Microsoft’s Help pages.

To get a landscape page

1. Insert a Section Break: Next Page before the page you want to make landscape
2. Insert a section Break: Next Page after the page you want to make landscape
3. Put your cursor in the page you want to make landscape
4. In the Ribbon, click on the Page Layout tab
5. In the Page Setup section, click on Orientation
6. Select Landscape
To correct the placement of a page number on a landscape page

- **GETTING THE PAGE NUMBER IN THE RIGHT AREA**
  1. Right click the footer area to access the Footer Update
  2. Click Edit Footer
  3. Go to “Page Number”
  4. Click on “Page Margins”
  5. Select “Vertical Right”

- **FIXING THE TEXT DIRECTION**
  1. Click on the newly inserted page number (it will be the wrong size and have the word Page in it—you’ll fix this using the below)
  2. Go to the Drawing Tools tab
  3. Click Text Direction and select Rotate 90 degrees
  4. Do this until it is facing the correct direction

- **FIXING THE STYLE**
  1. Click on Align Text
  2. Select Align Text Right
  3. Delete the word Page
  4. Apply a font size and font type consistent to your document’s text
  5. Make the box around the number smaller

- **FIXING THE PAGINATION**
  1. Highlight the number
  2. Click on the Design Tab in the Ribbon
  3. Click on Page Number
  4. Click on Format Page Number
  5. Click the box next to Start At
  6. Type the correct page number in the box next to Start At

- **GETTING THE NUMBER IN THE RIGHT PLACE**
  1. If your Ruler is not already on, Click on View and check the box next to Ruler
  2. Using the Ruler as a guide position the page number:
     3. 0.5” from the right edge*
     4. 1” from the bottom edge*

*This can be difficult to get exact, so please just get it as close as you can
• HIDING THE PAGE NUMBER AT THE TOP OF THE PAGE

OPTION 1:
1. Highlight number
2. Click on Home tab in Ribbon
3. In Font section, set font color to white

OPTION 2:
1. Click on Insert in Ribbon
2. Click on Shapes
3. Select a square
4. Draw it over the top number
5. Set Shape Fill to white
6. Set Shape Outline to white

Cover Pages

Cover pages are required for LIST OF REFERENCES, APPENDICES, VITA, and PUBLICATION. (When tables or figures are inserted together as a large group at the end of your thesis between REFERENCES and APPENDICES, cover page is also required with the heading, TABLES or FIGURES.)

Cover pages must not have any page numbers, and shouldn’t be counted in the page count. They are excluded from pagination.

Heading on cover page must be written in all caps and placed in the middle of the page.
To apply the setting:
Go to Page Layout tab, and change the top margin to 2” from Custom Margin.

Cover pages don’t count toward the page count and there should NOT include page numbers. Page number on cover page can be removed in two ways: deactivating “Linked to Previous” with Section Break: Next Page or simply covering it with white text box—no outline. Using text box is the easiest way for all types of Word versions.
To hide the page number on a cover page

1. Go to Insert and choose text box.
2. Apply text box on the page number.
3. Choose white for fill in color and select no outline.

Pagination has to be continued skipping cover page. To have the correct page number starting on the page after cover page, the pagination is continued from the page before cover page.

To paginate after a cover page

1. Insert Section Break: Next Page before the cover page and on cover page.
2. Go to the page after the cover page and double click the page number to activate the Design tab.
3. Choose “Format Page Number” and type in correct page number in the Start at:___ field.

If you continue to see a page number on the cover page, simply use white text box with no outline to cover the page number.

Alternately, you can insert cover pages after you’ve converted your thesis to PDF using Adobe Acrobat Pro. If we request changes to your thesis after you submit, you’ll have to remember to insert the cover pages again before you resubmit.

To insert cover pages using Adobe Acrobat Pro

1. Create your cover page in Microsoft Word and save it.
2. Click on Tools (located in the upper right of the screen).
3. Under Insert Pages, choose Insert from File.
4. Select the file and click Open.
5. Choose where to place the cover page (it goes before the section it corresponds to; i.e.: APPENDICES cover page goes before the first page of the Appendices section) and click Okay.
Embedding Fonts

Embedding is required for your Word document before you convert your file into PDF. It is to stabilize the original format of your document for the readers.

If you do not embed your fonts, and the fonts you use are not available on the reader's computer, Adobe Acrobat will make its best guess at what font it should use as a substitute. This can result in significant differences between your original document and what the reader sees (particularly with symbol fonts):
http://www.etdadmin.com/cgi-bin/main/faq#pdf4

To embed your fonts
1. Click File tab or Office Button to select Word Options on the bottom.
2. When Word Options is displayed, choose Save on the left panel.
3. Check the first box to embed fonts in the file and leave the rest unchecked. If this is not done properly, ProQuest may bring an error message not allowing you to upload your PDF file.

Converting Word Files to PDF

We strongly recommend you use Adobe Acrobat Pro. Adobe offers free 30-day trial downloads:
http://www.adobe.com

To convert using Acrobat
1. Make sure your fonts are embedded.
2. Click Save As from File/Office Button and save your file in PDF
3. Stabilized Method (to bring better quality on your tables and figures):
4. Go to Print and choose ADOBE PDF from the printer selection.
5. Click OK to continue and assign a new file name to save your file in PDF.
To combine PDF Files using Acrobat

This is how you will attach GS Form 30 before the first page of your thesis document

1. Open your PDF thesis.
2. Click on Tools in the right side of the Ribbon.
3. Under Insert Pages click Insert From File.
4. Select your non-interactive PDF ETD Form 9 and click Okay.
5. Set the location to Before and check the button next to First Page, then click Okay.
6. Save your new, combined document.

To insert or replace pages in PDF using Acrobat

1. Open your PDF thesis.
2. Click on Tools in the right side of the Ribbon.
3. Under Manipulate Pages, click Replace.
4. Select the PDF you want to place in your thesis and click Open.
5. Under Original select the page(s) you want to remove and under Replacement select the pages from the new file you want to include, then click Okay.